
Instructions for Use of Maple in Mathematics 251

Fall 2003

Getting started. The computer programMaple is a powerful tool which can help you solve a
wide range of mathematical problems: it can differentiate, integrate, and otherwise manipulate mathematical
formulas, perform arithmetic calculations, plot curves and surfaces in two and three dimensions, solve
differential equations, and carry out a variety of other useful mathematical operations. At Rutgers, Maple
is available on the machines in the student computer labs and on the student computereden. The current
version of Maple isMaple9, which was released in the summer of 2003. It is scheduled to be installed
throughout the student labs by the beginning of the Fall 2003 semester. Descriptions of projects will be
given for Maple9, but the projects have been tested on several versions, so should run on whatever version
is available. On all systems, there is atext basedversion andgraphical worksheet interfaceversions.
Only the graphical version will be used here. On Unix systems, like eden, this graphical version is called
xmaple, since it is customized to run under the X windows system. Since there are no longer X-terminals
in the student labs, most work will be done on PCs., where all versions of Maple are usually installed on
the “Course Related Software” section of theStart Menu. It is also expected that the Microsoft Windows
desktop on the lab PCs will be taught to recognize Maple worksheets so that you can start Maple by selecting
the file that you want to open. The commands you use to do mathematics with Maple will be the same on
all these machines, there are differences among computers, such as in the way that files are opened, saved,
and printed.

When you identify yourself to the PC to start a session, be sure to check the box that requests access to
your home directory on eden. This will start a program calledWebDrivethat allows you access to files on
eden. You will use this to save worksheets between maple sessions.

Starting with Maple 9, each worksheet opens in its own window with aMenu Bar, consisting of a row
of menu buttons(File, Edit etc.) At the top of the window. Underneath the row of menu buttons is the
Tool Bar, most of which are shortcuts to menu commands. Directly below theTool Bar is theContext Bar,
which consists of more buttons which are shortcuts to menu commands. If you have enabledTool Tips
from theInterface page of the Options menu, when you place the mouse pointer on any of these buttons, a
rough idea of what the button does will appear. The rest of the window, except far a smallStatus Barat the
bottom is devoted to the worksheet. You can now give an instruction to Maple by placing the mouse pointer
on the worksheet (just to the right of the prompt>), typing a Maple command, and then typing a carriage
return. Maple carries out the command and prints a response. For example, if you type1 + 1; , Maple
will respond with2. Note that each Maple command ends with a semicolon. (If you forget the semicolon,
Maple will remind you.) If you select part of the worksheet, the right mouse button brings up aContext
menu that can be useful in editing the worksheet.

Getting Help. Since you will not be given a Maple manual, you should learn to use Maple by
using the built inHelp facility. There is aHelp Menu at the right end of the menu bar. Selecting any of the
items in this menu will open theHelp Browser Window (introduced in Maple 9 — a less convenient set
of help window were used in earlier versions). New users are presented with thisHelp Browser Window
when Maple starts. Only one Help page at a time will be visible, but the browser includes aHistory panel
as well as an index and a search tool.
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Maple Worksheets. The window which appears when you start Maple is called aMaple
worksheet. To complete each computer assignment in Mathematics 251 you are asked to turn in anedited
printout of your work; such a printout can be obtained by editing, and then printing, your worksheet. The
printout should include only the numerical, symbolic, and graphical output of Maple which is appropriate
for the solution of the problems assigned, plus text material interpreting the results obtained by Maple.
Using theT tool will insert a new line into the worksheet in text mode, allowing descriptive material to
be added. (Undocumented Feature: Prior to Maple 9, this tool modified the current line, but this change
is not described in the documentation. There is a place in theInsert menu for inserting text, but this does
not change the nature of the line where it is used, so use of the tool is preferred.) This can also be used
to label graphical output, but better results can be obtained using thetitle option in the plot instruction.
Maple includes various editing capabilities which should enable you to produce neat and coherent output,
and which we now describe.

To remove an unwanted portion of your Maple worksheet (e.g., a region containing commands that
you typed incorrectly or that were not directly relevant to the solution of the exercises), select the region
to be deleted by clicking the left mouse button at the beginning, then dragging the mouse across to the end
of the portion of the worksheet you wish to delete. The region should now be highlighted. TheDelete
key will purge what you have selected. A safer approach is to chooseCut from theEdit menu or toolbar.
This allows you to copy the removed region to a new location, select the region as above by selectingPaste
from theEdit menu or toolbar. There is also aCopy item in theEdit menu. that makes a region available
for pasting without removing it from the worksheet. These operations are borrowed from your computer’s
Window Manager, so it should be possible to copy parts of your Maple worksheet to other applications.
However, this may not work as smoothly as it does with applications that are more closely integrated with
the system. You can delete whole lines with theCtrl-Deletekey combination. You should experiment with
the different aspects of the user interface (mouse, keyboard, menu or toolbar items) to find the method that
you find easiest for customizing the appearance of your worksheet.

Sometimes it is useful to be able to place a comment after a Maple command, rather than insert text
elsewhere in the worksheet. To do this, enter the sharp symbol #. Everything typed on a line following this
symbol will be considered by Maple to be a comment, and therefore not executed.

To make your worksheet less cluttered, it is a good idea to have Maple suppress the output of various
commands, e.g., the commandwith(plots) or a command given to assign a name to a plot. To do this,
end the command with a colon (:), instead of a semicolon (;).

Obtaining Copies of the Labs in Worksheet Form. In some of the labs, part of
the lab will ask you to execute a string of Maple commands to learn what they do. To avoid retyping these
commands, you can first obtain a modified copy of the lab in worksheet form (a “seed file”) from the course
web page. This modified copy will omit instructions and problems and contain only strings of some of the
Maple commands you are asked to execute. Once you obtain this file, you can access it by following the
instructions in the next section. To save typing, outlines of the commands described in the labs have been
saved in “seed files”. These can be obtained from the course page using your internet browser. When you
have saved the file in your home directory, you can load it into a Maple session from theFile:Open menu.

Opening an Existing Worksheet. To open an existing worksheet, chooseOpen from
theFile Menu or the appropriate tool. Navigate to the correct directory and select the name of the file you
wish to open and then click onOK .

Note: Although you will see the output from your previous work,noneof the definitions made there are
currently active. You will need to selectExecute Worksheetfrom the Edit menu or toolbar. You may also
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hit theEnter key on individual lines to step through the worksheet, editing it as you restore your previous
state. By contrast,everything you did in the current session on different worksheets is remembered. The
restart; instruction can be used to cause Maple to clear previous definitions and revert to its initial state.
Depending on configuration, material in different worksheets may be either shared or kept separate. Until
you have more experience, it is better to work with only one worksheet at a time, begin your worksheet with
arestart; instruction, and useExecute Worksheetafter making many changes to restore the connection
between the order of the input and output in the worksheet.

To continue, you will need to know some basic commands and syntax of Maple.

Arithmetic. The operations addition, subtraction, multiplication, division, are indicated by+,
-, *, respectively. Fractions are represented exactly, and Maple automatically simplified them. Thus,
if you type1/3+1/6; , Maple will answer 1/2. Exponentiation is also available with the operator/, ˆ ,
but it should be used sparingly. Many expressions that we write using exponents are better described using
theexponential functiondescribed in a later section.

When operating on integers or fractions, Maple does exact arithmetic, rather than using decimal ap-
proximations. To get a decimal approximation, use the Maple commandevalf . The Maple command
evalf(4/7); produces a 10 digit approximation to 4/7—as will typing4.0/7.0; . Additional ac-
curacy can be obtained by including a second argument: typingevalf[20](4/7); will produce a 20
digit approximation. (Note: this form of theevalf function is now standard, replacing an older form
evalf(4/7,20); . The older form is still accepted, but no longer described in theHelp file. You can
change also precision for your whole Maple session by setting a new value to the reserved variableDigits .

Algebra. All grouping of expressions is done with the left and right parentheses — ( and
). Although the usual rules of precedence apply, parentheses can always be used to clarify your intent.
Variables are not restricted to single letter names, as in Elementary Algebra (and most Calculus textbooks).
You can use (almost) any string of letters and numbers that starts with a letter. As a result, the productxy
must be writtenx*y , notxy or x y ; if you typexy , Maple assumes you are referring to a variable called
“xy ”. Thus, to enter the expression(2x + y2)/(x2

+ y) + 1 into Maple, you type:

(2*x +yˆ2)/(xˆ2 + 2*y) + 1;

Recent versions of Maple allow you to use apalette(available from theView menu) to help build expressions.
Projects for this course use a “seed file” containing formulas given in the description with space for you to
add new formulas as you work through the project. You can add more space using theExecution Group
item of theInsert menu or the button on the toolbar that looks like the [> Maple prompt.

To help you do algebraic manipulations, Maple has the commandsexpand , factor , andsimplify ,
which you can learn about by using theHelp facility. It is often necessary toexpand and expression before
Maple will know what it means tosimplify it. In particular, Maple considers

(2*x +y)/(x + 2*y);

to be simple.
Algebraic numbers like the square root of 2 are considered exact quantities. If you enter

a:=(sqrt(2)+1)ˆ10;

Maple will appear to simply echo aprettyprint version of that statement. To get an answer in the form
3363+2378*sqrt(2), you need to follow this withexpand(a); .
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You can also solve algebraic equations by using the commandssolve (for exact answers) orfsolve
(for numerical answers to the accuracy specified byDigits ).

The standard functions. Note that the exponential function is built into Maple and is
referred to asexp . The numbere, if you ever need it, isexp(1) . If you have the fragmenteˆx in a
worksheet, it willlook right, but will usually give incorrect results when you try touseit. Similarly, the
numberπ has the special namePi — not pi which looks the same, but will be treated as an ordinary
variable. If you want to, you can saypi:=3; but this won’t affect the value ofπ or anything that depends
on it. However, Maple will fuss at you if you try to change the value ofPi . Maple also recognizes names
like log , ln , sin , cos , tan as standard functions. Those names are also protected against use as names
of variables. Normally,log is treated as a synonym forln — to get thecommon logarithmof 2 that your
calculator uses, you should writelog10(2.); or log[10](2.); . The Help page, “Initially known
mathematical functions” will give you a list of names of the functions that are always avaialable.

User-defined Functions and Expressions. In Maple, xˆ2 - 2*x +3 is an
expression. You can assign a name to this expression for future use by typingg:= xˆ2 - 2*x +3; .
Note that a colon is required before the equal sign in an assignment statement. Expressions can contain
several variables, as inh:= y*t - sin(y) . To evaluate an expression at a particular value, use the Maple
commandsubs . For example,subs(x=2,g); will produce the value 3. Maple also has a construct called
a function, defined by statements likef:=x -> xˆ2 - 2*x +3; .

We won’t often use functions, since it is easier to work with expressions, but you might see them in
examples onHelp screens. Someseed filesmay also define functions to extend the Maple language on that
worksheet. While we don’t expect you towrite functions in the Maple programming language, you should
have no difficultyreadingthese definitions.

Plots. The basic plotting command in Maple isplot . This command has many forms—for
example, several functions can be plotted at once—so you should look carefully at the examples given at
the end of itsHelp page to get some idea of its flexibility. There are many other plotting commands in
Maple; in this course we will use primarilyplot3d and implicitplot . To use some of the plotting
commands you must first issue the commandwith(plots); . For example, this is necessary in order to
use the commandimplicitplot . It is frequently useful to enlarge the size of a plot. To do this, place the
mouse pointer in the region occupied by the plot and click the left mouse button. This places a box around
the plot and changes the Menu Bar and Control Bar (and context menu) so that new options are offered to
manipulate the plot. The plot is resized by placing the mouse pointer at one of the small dots along the edge
of the box and dragging the pointer. When you have finished modifying the plot, move the mouse down to
the next prompt> and click the left mouse button. When viewing three dimensional plots, it is useful to
view the plot from different viewpoints. First, place a box around the plot by moving the mouse pointer in
the region occupied by the plot and clicking the left mouse button. Now, place the mouse pointer inside the
box and while holding down the left mouse button, move the mouse pointer to different positions. Explore
the effects of using theAxesand other commands on theMenu Bar. (In the current version, you see changes
immediately, but earlier versions required you to selectRedraw from a menu in order to see your changes.)

Vectors. As of Maple6, Maple now has two different packages for linear algebra. These packages
allow powerful operations to be introduced simple by calling them by name, but they impose a complicated
structure on everything they touch. As a result, simple things become more difficult. In this course, we
are mostly concerned with vectors as triples of numbers to represent points in space, and the operations
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that we need have been described simple using that notation. The generality used in Linear Algebra is not
needed. Maple includes a structure called alist that is easy to use and has all the properties that we need.
You describe a list by enclosing a sequence of quantities separated by commas in square brackets. Thus,
[1, 3, -1] describes a point, and[cos(t),sin(t),t] describes ahelix. The description of a space
curve like a helix can be directly differentiated with respect to its parameter as a step in using Calculus to
find properties of the curve. However, a special construction is needed to multiply all elements of a list by
a single expression. This is one place where a function is used to extend the Maple language.

Differentiation and Integration. In addition to performing basic calculations and eval-
uating expressions containing standard functions, Maple can also differentiate and integrate. Thediff
command differentiates expressions. For example,diff(x*sin(x), x); differentiatesx sin(x) with
respect tox. If you have named an expression, it is a useful convention to introduce a modification of
that name as a name for the derivative (or partial derivatives). That is, if you havey:=x*sin(x); ,
you can writey1:=diff(y,x); . A second derivative can then be found, and named, quickly by
writing y2:=diff(y1,x); to differentiate the first derivative using the name that you introduced. If
you need a second derivative without seeing the first derivative, eitherdiff(x*sin(x), x, x); or
diff(x*sin(x),x$2); may be used. If you have typedg:=xˆ2*y; , thendiff(g,x); is the first
partial derivative ofx2y with respect tox anddiff(g,x,y); is the mixed second partial derivative.

Note that Maple assumes that everything not involving the variable with which it is differentiating is
constant. This means that no special notation is required to distinguish partial derivatives of expressions
from ordinary derivatives. Although we claim to be differentiatingfunctions in Calculus, the techniques are
based on examining howvariablesappear inexpressions, so the way that Maple works with expressions is
more familiar.

The command for both definite and indefinite integration isint . If Maple cannot evaluate a definite
integral exactly, numerical integration may be used. Definite integrals are evaluated using a single instruction
written like int( sin(x), x=0..Pi ); to get∫ π

0
sinx dx.

It is not necessary to apply thesubs instruction to the result of indefinite integration, although that approach
gives the same answer. The role ofdx in the mathematical notation for integrals is played by including the
name of the variablex in the second argument of theint instruction.

Printing your Maple Worksheet. To print your Maple worksheet, choosePrint from
the File menu or click on the print button in theTool Bar (its position varies, but it is with the other file
tools at the left and it looks like a printer). A panel will appear with the options “Output to File” and “Print
Command” at the top. Clicking on “Print Command” will direct your output to the printer if the command
has been correctly entered, while clicking on “Output to File” places your output in a file, whose name will
be chosen in another box (the default isout.ps). If you wish to change the file name or the print command,
click in the box and type your changes. Since the file will be a postscript file, the file name should have the
form something.ps. When you have finished making your choices, click on the “Print” button.

There is also aPrint Preview that lets you see how your worksheet will appear before you commit it
to paper.

There is a item in theInsertMenu that allows you to add a page break to your worksheet. In Maple 9
the location of the break is shown in the worksheet on your screen.
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Saving your Maple Worksheet. If your work is interrupted, you can save your work
so that you can later resume where you left off. To save your Maple worksheet, chooseSave Asfrom the
File menu. Then type the name of the file in which you wish to save your worksheet in theSelectionbox
where the mouse pointer is (replacing the asterisk). The file name should have the formsomething.mwsfor
compatibility with earlier versions of Maple, orsomething.mwfor the xml format introduced with Maple 9.
After you have typed the filename, click on “OK” to save the file. Once you have named the worksheet and
saved it in a file, you can save further changes by choosingSavefrom theFile menu. Maple automatically
keeps track of the filename.

Ending your Maple Session. To end your Maple session, chooseExit from theFile
menu. When you close a worksheet, or exit the program, Maple will prompt you to save worksheets that
have changed since the last save.

Useful Commands and Techniques. If Maple gets hung up in a calculation or is
taking too long, click the mouse on thestopbutton in theTool Bar menu.

Any Maple command previously entered in your worksheet can be re-executed without retyping it in a
new location. Simply move the mouse to the position of the command you wish to execute and hit theEnter
(or Return) key.

It is often useful to be able to refer later to the result of a computation—the output of some command—in
a simple way. To make this possible, simply assign the output of the command to a variable. For example, if
you entera:= evalf(2*Pi); then you can later square the result ofevalf(2*Pi); by typinga*a; .
It you find that you need a recent result that was not named, the special names%, %%, etc. may be used to
refer to the previous result, the one before that, etc. (the instructions are not clear about how much of the
history can be retrieved in this way). A better solution might be to add a name the line that computed the
expression and re-execute that line.

You can assign a name to a plot just as described above for assigning a name to an expression. Several
previously named plots can then be displayed on the same graph by using the commanddisplay . This is
part of theplots library. Looking in the documentation for that library may be the easiest way to find the
help page for this function.

Only the most recent assignment to a name is remembered. You can unassigna by typinga:=’a’; .
To clear all the assigned variables in a Maple session, you can typerestart; as indicated earlier. If you
are unsure of what value has been assigned to the namea, you can typea; at the current prompt. Such
working notes should be edited out of the worksheet before you submit it.

Getting Help From Other Students.
The purpose of the Maple assignments is partly to learn about Maple, a very useful program for symbolic,

numerical, and graphical computations, and partly to help you understand the material in the course. Just as
with other homework assignments, it is permissible and helpful to discuss the Maple labs with other students.
However, the Maple labs you are turning in are being graded and will be part of your final course grade,
and the printed form of the worksheet is expected to be the work of the student who submits it. The grader
will concentrate on the text comments that interpret the results of the computation, and these are expected
to reflect yourindividual understanding of the topic.
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